Contents

DOCUMENT CHANGE HISTORY .................................................................................................................................. 6

BOOK MANAGEMENT ........................................................................................................................................ 7
  Understanding book management in Brightspace Learning Environment ......................................................... 7
  Add a book .......................................................................................................................................................... 7
  Edit a book ....................................................................................................................................................... 7

COURSE ADMINISTRATION ............................................................................................................................... 7
  Course Administration basics .......................................................................................................................... 7
    About course administration .......................................................................................................................... 7
    About course colors ..................................................................................................................................... 8
    About course locale ...................................................................................................................................... 8
    Change the status of a tool .............................................................................................................................. 8
    Activate a course offering .............................................................................................................................. 9
    Course Admin offering information .............................................................................................................. 9
    Rename a tool .............................................................................................................................................. 9
  Search for courses .......................................................................................................................................... 10
  Add a link to Brightspace Help to your navbar ............................................................................................... 10

Managing course components ........................................................................................................................... 11
  About copying course components between org units .................................................................................... 11
  Special considerations when copying course components ........................................................................... 13
  Copy course components ............................................................................................................................... 13
  About importing course components from a file ............................................................................................ 14
  Import course components ............................................................................................................................ 14
  Course Import Compatibility ............................................................................................................................ 15
  Troubleshooting: Course Conversion ............................................................................................................ 16
  About exporting course components ............................................................................................................ 19
  Export course components .............................................................................................................................. 19

© 2017 by D2L Corporation. All rights reserved.
What course components can be exported? ........................................................................................................20
IMS Common Cartridge ...........................................................................................................................................20
About IMS Common Cartridge ................................................................................................................................20
About importing IMS Common Cartridge packages ............................................................................................21
How protected IMS Common Cartridge resources are handled ...........................................................................21
IMS Common Cartridge versions ..........................................................................................................................21
Mobile Branding Administration ................................................................................................................................25
About Mobile Brand Administration ....................................................................................................................25
Update mobile branding ......................................................................................................................................25
Mobile branding reference sheet .........................................................................................................................26
LEARNING TOOLS INTEROPERABILITY: CONTENT-ITEM MESSAGE SERVICE 1.0 ....................................................28
Add third-party content from the Content tool ......................................................................................................28
Add third-party content from Insert Stuff ............................................................................................................29
Add third-party content from Insert Quicklink .........................................................................................................29
Add third-party content from Course Import ...........................................................................................................29
Add third-party content from Import/Export/Copy Components ...........................................................................29
METADATA .........................................................................................................................................................30
Metadata basics .......................................................................................................................................................30
What is metadata? ..............................................................................................................................................30
Metadata and the Content tool ...........................................................................................................................30
Metadata and the Brightspace Learning Repository tool ....................................................................................30
Metadata interfaces ............................................................................................................................................30
Best practices for using metadata .......................................................................................................................30
Troubleshooting metadata conflicts ....................................................................................................................31
Using metadata views ...........................................................................................................................................32
Metadata views .......................................................................................................................................................32
Create a metadata view ........................................................................................................................................33
Import a metadata view .........................................................................................................................................34
Export a metadata view .........................................................................................................................................34
Using metadata languages ......................................................................................................................................35
  Set initial metadata language .............................................................................................................................35
  Add a metadata language ...................................................................................................................................35
Using metadata templates ......................................................................................................................................35
  Metadata template types .....................................................................................................................................35
  Create a metadata template ...............................................................................................................................36
  Import a metadata template ...............................................................................................................................36
  Export a metadata template ...............................................................................................................................36
Using metadata taxon schemas ..................................................................................................................................36
  What is a taxon schema? .......................................................................................................................................36
  Taxon schema types .............................................................................................................................................37
  Define your taxon schema in an XML file .............................................................................................................37
  Import your taxon schema from an XML file .......................................................................................................37

INTELLIGENT AGENTS..........................................................................................................................................37
Intelligent Agents basics ........................................................................................................................................37
  What is the Intelligent Agents tool? ....................................................................................................................37
  Considerations for setting up agents ...................................................................................................................38
  Best practices for creating and using agents .......................................................................................................38
  Replace strings for agents ..................................................................................................................................39
Using agents ............................................................................................................................................................39
  Create an agent ...................................................................................................................................................39
  Edit an agent ......................................................................................................................................................40
  Copy an agent ....................................................................................................................................................40
  Delete an agent ..................................................................................................................................................40
  Restore an agent ................................................................................................................................................41
  Update Intelligent Agents settings ......................................................................................................................41
  Run an agent manually .......................................................................................................................................41
  Perform a practice run .......................................................................................................................................42
  Change the status of an agent .............................................................................................................................42
View the history of an agent ................................................................. 42
View scheduled agents’ run time .......................................................... 42
View an agent’s next run date ............................................................... 42

REGISTRATION ......................................................................................... 43
About Self Registration ........................................................................ 43
Create new Brightspace Learning Environment users using the Self Registration tool ........................................ 43
Enroll existing Brightspace Learning Environment users using the Self Registration tool ................................ 43
Enable self registration in a course offering ...................................... 44
Unenroll users from a course offering using the Self Registration tool .......................................................... 44
Import users using the Self Registration tool ..................................... 44
Run Self Registration reports ............................................................... 45
Create registration forms .................................................................... 45
Associate a registration form with a course ...................................... 46
Set restrictions on self registration ..................................................... 46
Approve self registrations .................................................................. 47
Delete or reject self registrations ....................................................... 47
Troubleshooting self registrations ...................................................... 48

REPLACE STRINGS .................................................................................. 48
Replace Strings .................................................................................... 48

SCORM .................................................................................................... 52
About SCORM ....................................................................................... 52
Add a SCORM package to the Content tool ....................................... 52
Move your imported SCORM content to a different module .......... 53
Adjust the display size of your SCORM object .................................. 53
Remove a grade item from a SCORM object after the package is imported .................................................. 54
Publish a SCORM package as a SWF or HTML5 file with automatic grade creation .................................. 54
Publish a SCORM package as a SWF or HTML5 file with manual grade creation ..................................... 54
Troubleshooting .................................................................................. 55

My SCORM objects are too small or too large in the Content tool ............................................................ 55
The top of my SCORM objects are being cropped in the Content tool

When I view my SCORM package in the Content tool, I receive a notification that an error occurred initializing communications with the LMS.

An error appears when I close the window that opened to play my SCORM package.

An "LMSSetValueError:cmi.core.lesson_status to [unknown] Incorrect Data Type" error appears when I open my SCORM object.

ABOUT D2L
Document Change History

This version of the document replaces all previous versions. The following table describes the most recent changes to this document.

<table>
<thead>
<tr>
<th>Revision Date</th>
<th>Summary of Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>March 2, 2017</td>
<td>• Updated <em>About SCORM</em>, <em>Add a SCORM package to the Content tool</em>, <em>Move your imported SCORM content to a different module</em>, <em>Adjust the display size of your SCORM object</em>, <em>Publish a SCORM package as a SWF or HTML5 file with automatic grade creation</em>, <em>Publish a SCORM package as a SWF or HTML5 file with manual grade creation</em>, and <em>An error appears when I close the window that opened to play my SCORM package</em> to reflect the addition of a new SCORM solution to the Brightspace platform.</td>
</tr>
<tr>
<td>January 5, 2017</td>
<td>• Added <em>Add a link to Brightspace Help to your navbar</em> topic to Course Administration section.</td>
</tr>
<tr>
<td></td>
<td>• Updated <em>About SCORM</em> topic to include information on SCORM versions supported by Brightspace Learning Repository.</td>
</tr>
<tr>
<td></td>
<td>• Updated the <em>Copy course components</em> topic with a note about copying groups to courses.</td>
</tr>
<tr>
<td>November 3, 2016</td>
<td>• Updated formatting for consistency.</td>
</tr>
<tr>
<td></td>
<td>• Updated the <em>Create an agent</em> topic to include the note about scheduled intelligent agents.</td>
</tr>
<tr>
<td></td>
<td>• Updated the <em>Delete an agent</em> topic to add information about multi-selecting and deleting agents.</td>
</tr>
<tr>
<td></td>
<td>• Updated the <em>Run an agent manually</em> topic to include a note that you can run an agent at any time in a course with a passed end date and to mention that agents do not need to be enabled in order to set up a manual run.</td>
</tr>
<tr>
<td></td>
<td>• Updated the <em>Perform a practice run</em> topic to include the note that an agent does not need to be enabled to perform a practice run.</td>
</tr>
<tr>
<td></td>
<td>• Added <em>Restore an agent</em>, <em>View scheduled agents’ run time</em>, and <em>View an agent’s next run date</em> topics.</td>
</tr>
<tr>
<td>October 6, 2016</td>
<td>• Added <em>Add third-party content from Course Import</em>, and <em>Add third-party content from Import/Export/Copy Components</em> topics to reflect new information.</td>
</tr>
<tr>
<td>September 1, 2016</td>
<td>• Added <em>Add third-party content from the Content tool</em>, <em>Add third-party content from Insert Stuff</em>, and <em>Add third-party content from Insert Quicklink</em> topics.</td>
</tr>
</tbody>
</table>
The content in this guide is applicable to the most recent version of Brightspace Learning Environment unless otherwise noted.

**Book Management**

Understanding book management in Brightspace Learning Environment


**Add a book**

1. On the navbar, click **Course Admin > Book Management**.
2. On the **Book Management** page, click **Add Book**.
3. Enter the ISBN.
4. If you want to classify the book as required reading material for a course, select the **Required** check box.
5. Click **Add**.

**Edit a book**

1. On the navbar, click **Course Admin > Book Management**.
2. Beside the ISBN you want to edit, click the **Edit** icon.
3. Make your changes.
4. Click **Save and Close**.
Course Administration

Course Administration basics

About course administration
The Course Administration area is a central area for accessing tools related to setting up and managing your course. From the Course Administration area, you can access many tools to help you run your course smoothly. Some of the tasks you can accomplish include:

- Editing course colors
- Enabling and disabling course tools
- Renaming course tools
- Managing course offering information
- Importing course components

About course colors
You can enhance the appearance of your course and help users identify your course more easily by modifying the colors used in the interface. Brightspace Learning Environment uses three color settings to render the areas within a course.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dark Color</td>
<td>Used for the title bar, widgets, and pop-ups. White text is shown against this color.</td>
</tr>
<tr>
<td>Light Color</td>
<td>No longer used in most areas. D2L recommends you use the same color as the Dark Color. White text is shown against this color.</td>
</tr>
<tr>
<td>Soft Color</td>
<td>Used for tabs. Black text is shown against this color.</td>
</tr>
</tbody>
</table>

About course locale
If your organization supports multiple locales, you can change the default locale used for your course offering. Normally users can specify their own locale within their preferences. You also have the ability to override locale preferences so that all users see the same locale in your course. You might use this if you are teaching a language immersion course and want all the cultural formatting and text in the course offering to reflect the language you are teaching.
Change the status of a tool

Course tools, such as Quizzes, Content, Discussions, Chat, Grades, and so on, are course components that you add to your course offering to share learning content, foster interaction, and evaluate performance. You can enable and disable course tools to specifically tailor your course to your pedagogy and course materials.

Before enabling a tool, be aware of the following:

- Some activated tools can only be accessed from the navbar or home page widgets.

Before disabling a tool, be aware of the following:

- Release conditions based on the tool are not enforced as long as the tool remains disabled.
- Competency activities associated with the tool are hidden, but are still associated with any learning objectives to which they are attached. Users cannot complete these learning objectives while the tool is disabled. You should detach or delete any activities associated with a tool before disabling the tool.
- Grade items associated with the tool remain, but you must manually update them in the grade book.
- Quicklinks to the tool’s items persist but a “No Resource Found” message displays when they are followed. You should remove any related quicklinks when you deactivate a tool.
- Deactivating a tool does not delete any items or user data inside the tool; it simply hides the tool from your course offering.

1. On the navbar, click Course Admin.
2. Click Tools.
3. Do one of the following:
   - To enable a tool, toggle its status to On.
   - To disable a tool, toggle its status to Off.

Activate a course offering

Activating a course makes the course appear in the registered learner’s My Courses widget. Activating a course also makes it available to learners if you have not set a Start Date and/or End Date for your course.

If you set a Start Date for your course that is later than the day you activate your course, the course appears in the My Courses widget, but is not available to learners until the date specified.

If you set an End Date for your course and do not deactivate your course, after that specified date passes, the course remains visible in the My Courses widget, but is not available to learners.

1. On the course home page, click Course Admin > Course Offering Information.
2. Select the Course is active check box.
   Tip: You can deactivate a course offering to hide it from learners without actually deleting it. This way the content (including user data) can be kept for future use.

3. Click Save.

Course Admin offering information
You can edit the properties of your course offering, including course colors and course locale, on the Course Offering Information page.

1. On the navbar, click Course Admin.

2. Click Course Offering Information.

3. Make your changes.

4. Click Save.

Rename a tool
You may want to rename a tool if your organization or geographic area is more familiar with different terminology. For example, you could rename Assignments to Assignments.

Changing the custom navbar name for a tool does not replace all uses of the original term throughout the system. It only changes the display name for the tool on the navbar. To replace all references to a specific term, a site administrator can update your organization’s language pack using the Manage Languages tool.

1. On the navbar, click Course Admin.

2. Click Tools.

3. In the Custom Navbar Name field for the tool that you want to rename, enter the new tool name.

4. Press Enter or click outside the field. Your changes save automatically.

Search for courses
The Search for courses field only appears if you have been enrolled in the number of courses specified in the d2l.Tools.Homepages.MaxCourses (Org) configuration variable. The default setting for this configuration variable is 25.

1. On the Course Updater page, in the Search for courses field, enter a value.

2. To add parameters to your search, click Show Advanced Filters.

3. Do any of the following:
   - To search for courses by department, in the Department drop-down list, select a department.
   - To search for courses by semester, in the Semester drop-down list, select a semester.
To search for courses by status, in the **Active** drop-down list, select active or inactive.

To search by start date, in the **Course Start** drop-down list, select an option. In the filter fields, enter dates.

To search by end date, in the **Course End** drop-down list, select an option. In the filter fields, enter dates.

4. Click the **Search** icon.

**Add a link to Brightspace Help to your navbar**

You can add a link to the Brightspace help site to your course’s navbar. The link opens Brightspace Help in a new window.

1. From the **Admin Tools** menu, select **Navigation and Themes**.
2. Click the link for the navbar you want to add the help link to.
3. On the **Edit Navbar** page, in the **Links** area, click **Add Links**.
4. In the **Add Links** dialog window, select the **Brightspace Help** check box.
5. Click **Add**, and then **Save and Close**.
6. On the navbar, click the **Brightspace Help** link. A new browser window opens to the welcome page of the Brightspace Help site.

To learn how to effectively navigate and utilize Brightspace Help, in the left-hand navigation panel, click Navigating in Brightspace Help.

### Managing course components

**About copying course components between org units**

The copy components utility lets you copy quizzes, content, grade items, discussion forums, Assignments folders, courses with S3 model configurations, and nearly every other type of component from another course offering or a course offering’s parent template. Copying components saves you from having to recreate your course’s resources and can significantly reduce the amount of work required to create or re-offer a course.

You can use the copy components feature to:

- Reuse components created in a previous course offering.
- Add components created by your peers into your own course offering.
- Set up standard components inside a course template and copy them into a new course offering each time a course is re-offered.
- Copy courses with S3 model configurations
- Include the selected course as an additional historic course
To copy components between course offerings, you must be enrolled in both offerings. You also need to be enrolled in and have access to the parent template to copy components from the parent into a course offering.

To copy courses with S3 model configurations, you must enable the Student Success System at the instance and org level.

You can also copy components into a course template, and you can create standard components within a template and then copy them into the template’s associated course offerings.

The following table addresses some common concerns around copying course components between org units:

<table>
<thead>
<tr>
<th>Concern</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overwriting and duplicating content</td>
<td>The only components you might overwrite are course files. Course files are overwritten if one of the files being copied has the same name as an existing file. No other components are overwritten.</td>
</tr>
<tr>
<td></td>
<td>For example, if you have three checklists in your current course offering, and copy two checklists from another offering, you will now have a total of five checklists in the current offering. This is true even if the components are identical. If you are copying components from the same source multiple times, be careful not to copy the same items more than once or you will create duplicates.</td>
</tr>
<tr>
<td>User privacy might be compromised when copying course components</td>
<td>User data is not copied. For example, if you copy the discussions component, only the forums and topics are copied, not the posts inside the topics. Similarly, if you copy Assignments folders or quizzes, user submissions and quiz attempts are not copied.</td>
</tr>
<tr>
<td>Links and associations between components</td>
<td>D2L recommends that you copy all components between courses to ensure you maintain all desired associations, and then delete any undesired material in the new course.</td>
</tr>
<tr>
<td></td>
<td>If you are copying linked or associated components, you must copy all of the related components at the same time. For example, if a discussion topic has release conditions based on the results of a quiz, you must copy all three components—discussions, quizzes, and release conditions—at the same time. Similarly, if you have a quiz that is associated with a grade item, be sure to copy both the quiz and the grade item at the same time. As long as the associated components are copied together, links between them are retained.</td>
</tr>
<tr>
<td></td>
<td>To copy release conditions, you must select the Release Conditions component.</td>
</tr>
</tbody>
</table>
Special considerations when copying course components

When you are copying course components, ensure that you have considered the following implications or associated tasks.

<table>
<thead>
<tr>
<th>Component</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competencies</td>
<td>Competencies, learning objectives, and associated activities are copied.</td>
</tr>
<tr>
<td>Content</td>
<td>Does not include files or content display settings; you must select these as separate components. Be sure to copy all course files used in the course as well as the content topics or only the content topic structure is copied.</td>
</tr>
<tr>
<td>Checklist</td>
<td>Due dates for checklist items are not changed when you copy them.</td>
</tr>
<tr>
<td>Groups and Sections</td>
<td>The new course does not automatically enroll groups and sections. You must enroll users yourself.</td>
</tr>
<tr>
<td>Navbars</td>
<td>If you have modified the names of any tools, you must also copy the tool names.</td>
</tr>
<tr>
<td>Release Conditions</td>
<td>Only release conditions that reference or are attached to other components are copied at the same time as the component. For example, if a quiz has a release condition that refers to a content topic, the release note is only copied if both the quiz and the content topic are copied at the same time. If you copy release conditions without selecting any other component, there is no action.</td>
</tr>
</tbody>
</table>

Copy course components

In order to mitigate the risk that large courses may result in timeout failures for users, the Copy Course components job functions as an asynchronous job. You can view the progress of the copying job by clicking View History link.

1. In the course offering that you want to copy components into, on the navbar, click Course Admin > Import/Export/Copy Components.

2. Do one of the following:
   - Select Copy Components from another Org Unit. Click Search for offering and locate the course offering containing the components you want to copy. Click Add Selected.
   - Select Copy Components from Parent Template to copy components from the course template the current course offering belongs to.

3. Do one of the following:
   - To copy all course components, click Copy All Components. D2L recommends that you copy all components between courses to ensure you maintain all desired associations, and then delete any undesired material in the new course.
To specify the components you want to copy, click **Select Components**. Select your components. To see details for course components, click the **Show the current course components** link, then click the **View Detail** icon beside a component to see existing items. For those course components that provide the option to Include associated files, D2L recommends leaving the option turned on. Click **Continue > Finish**.

**Note:** If you encounter issues with the Include associated files option and want to remove it, contact D2L Support to ask them to turn off the D2L.LE.Conversion.Features.ICopyAssociatedFilesFeature feature toggle.

4. Do one of the following:
   - To copy another package, click **Copy Another Package**.
   - To see the results of your copy, click **View Content**.

**Notes:**

- If you copied a course with S3 model configurations, the course is listed in the Student Success System Administration page (Admin Tools > Student Success System).
- Now when you copy groups to courses, the group setup (grade item, assessment option, and so on) is also copied over.

For information on the Student Success System permissions, refer to the Administering Courses – Administrator Guide.

### About importing course components from a file

You can import components created in other learning management systems, provided by content vendors, or created in a content creation program (like Respondus). To import components, you must have a file containing the components in a format supported by the Import tool.

You can also import components from Brightspace Learning Repository.

**Import course components**

1. In the course offering containing the components you want to copy, on the navbar, click **Course Admin > Import/Export/Copy Components**.

2. On the **Import/Export/Copy Components** page, select **Import Components**.

3. Click **Start**.

4. Select the file you want to import.

5. Choose whether to **Import All Components** or **Select Components** and then follow the prompts.

If you import course components with names that already exist in the course, or you import multiple components with the same name, duplicate names appear; they are not overwritten. For example, if your course contains a discussion topic called Exam Review and you import a course package that contains a discussion topic called Exam Review, your course will contain two topics called Exam Review.
**Course Import Compatibility**

The following table provides a list of learning management systems (LMS) and content providers that you can import course content from. It is recommended that you work with your site administrator or D2L Account Manager when importing content from another LMS.

<table>
<thead>
<tr>
<th>Component</th>
<th>IMS CP</th>
<th>QTI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blackboard 6.0</td>
<td>1.1.2</td>
<td>1.2.1</td>
</tr>
<tr>
<td>Blackboard 6.1.5/6.2/6.3</td>
<td>1.1.3</td>
<td>1.2.1</td>
</tr>
<tr>
<td>Blackboard 7</td>
<td>1.1.3</td>
<td>1.2.1</td>
</tr>
<tr>
<td>Blackboard 8</td>
<td>1.1.2</td>
<td>1.2.1</td>
</tr>
<tr>
<td>Blackboard 9</td>
<td>1.1.2</td>
<td>1.2.1</td>
</tr>
<tr>
<td>Common Cartridge® 1.0</td>
<td>1.1.3</td>
<td>1.2.1</td>
</tr>
<tr>
<td>Common Cartridge 1.1</td>
<td>1.2</td>
<td>1.2.1</td>
</tr>
<tr>
<td>Common Cartridge 1.2</td>
<td>1.2</td>
<td>1.2.1</td>
</tr>
<tr>
<td>Common Cartridge 1.3 (and ThinCC1.3)</td>
<td>1.2</td>
<td>1.2.1</td>
</tr>
<tr>
<td>Desire2Learn 8.x</td>
<td>1.1.3</td>
<td>1.2.1</td>
</tr>
<tr>
<td>Respondus 2.0</td>
<td>N/A</td>
<td>1.2.1</td>
</tr>
<tr>
<td>Respondus 3.x</td>
<td>N/A</td>
<td>1.2.1</td>
</tr>
<tr>
<td>SCORM® 1.2</td>
<td>1.1.2</td>
<td>N/A</td>
</tr>
<tr>
<td>SCORM 1.3 (2004)</td>
<td>1.1.3</td>
<td>N/A</td>
</tr>
<tr>
<td>WebCT® CMU 1.x</td>
<td>1.1.2</td>
<td>1.2.1</td>
</tr>
<tr>
<td>WebCT CMU 2.0</td>
<td>1.1.3</td>
<td>1.2.1</td>
</tr>
</tbody>
</table>

You can convert packages into importable D2L-formatted packages using separate conversion tools. Work with your D2L Account Manager to discuss converting and importing from the following systems:

- ANGEL 7.3/7.4/8
- Blackboard CE 6 (WebCT CE 6)
Troubleshooting: Course Conversion

The following errors might be encountered during course conversion into D2L format. Try these troubleshooting steps first, and if they don't work, contact support for a more in-depth investigation of the issue.

Error: Package was not recognized

A package may be not recognized if:

- It is not in a course archive format (for example, it is a .ppt or .pdf file instead of a course package exported from an LMS).
- It was exported from a vendor that is not yet supported by D2L.
- It failed to unzip.

Package Failed to Unzip

Symptoms

When importing a course package, you encounter the message: "The package was not recognized". The processing logs indicate "Unpackaging uploaded file" followed by "Unsupported file format". If the package was successfully unzipped, the processing logs would indicate "Successfully unpackaged file" instead.

The processing logs also indicate that the final status of the issue was "NoConversion". You can access the processing logs directly on the error page in Course Import by clicking on "View Processing Logs".

Cause

The following are common causes of this error:

- The package is not a valid archive file (for example, .zip, .mbz, .imscc, etc. which have been exported from an LMS). Verify that the file is an Archive or Compressed Folder file type before attempting your course import. The following file types are not valid for importing a course: .pdf, .ppt, .docx. If you are trying to add course content, use Content Tool - Add Module instead.
- The course package does not have an imsmanifest.xml at the root level and it may instead be located in a sub-folder.
- The course package contains files paths that are longer than 128 characters which is a Windows limit.
• An archive file has been corrupted or damaged.

Resolution

If you are using an archive file, to verify your course package can be extracted, try to unzip the package locally first. Try the following steps to resolve the problem:

1. Use the built-in operating system extraction program and try to unzip the file on your computer.

   If you successfully unzipped the package on your local computer, re-zip the file using your local operating system zip program or the program you were using. Retry the course import with the newly zipped package.

2. Unzip the package and examine the folders structure to ensure that the imsmanifest.xml file is at the root level. If the imsmanifest.xml file is not at the root level move the file to this location and re-zip the package and retry the course import.

3. Use WinRAR (http://www.rarlab.com/) to unzip the file on your computer.

   Your package may contain file paths longer than 128 characters. In this case, most extraction programs on Windows will fail. WinRAR will still extract the files, but will warn that files exceeding the maximum path length were truncated. Once the extraction is complete, it is recommended that these paths are truncated manually or removed. Then re-zip the files and retry the course import.

4. Re-export your course package from the original source.

   If neither of the previous troubleshooting steps worked and the extraction still fails, your course package is likely damaged. Re-export the course package from the original LMS and retry the course import with a newly exported package.

Error: Package was not converted

This error commonly arises due to issues within the course package itself:

• There may be key files missing (for example, imsmanifest.xml is a typical file expected to be among the course package structure).

• There may be issues with XML in some of the files (for example, the files may have illegal characters or unmatched opening and closing brackets).
Typically in these cases, it is recommended to review the processing logs and inspect the specific complaint. Then explore the contents of your package to verify that the information is corrected. You can also try to re-export the package from the original source.

**Invalid HTML**

**Symptoms**

When importing a course package, you encounter the message "The package was not converted". The processing logs may indicate that an invalid or unexpected character has been encountered.

The processing logs also indicate that the final status of the issue was "ProcessingFailed". To access the processing logs directly on the error page in Course Import, click View Processing Logs.

**Cause**

Invalid XML can often cause conversions to fail. Sometimes the error directly names the exact file that is causing the problem. If it is not explicitly stated, try the main imsmanifest.xml file. If the manifest is improperly formed, serious issues may occur.

**Resolution**

To verify that an XML file is valid:

1. Open the file in Internet Explorer. If the XML is valid, it should render correctly; if not, the page will remain blank or report an error.
2. Use an online XML validator like: [http://www.xmlvalidation.com/](http://www.xmlvalidation.com/)
3. If the XML is invalid, correct the XML, re-zip the package and retry importing your course package.
4. If the XML is valid, the issue with your package is likely in the structure of the package (for example, missing key files). In this case, re-export the package from the original source and retry importing your course package.

**Error: Conversion Service is Temporarily Unavailable**

If the Conversion Service is not available, it may relate to temporary issues that are being monitored by D2L support and will be resolved shortly. However, if you repeatedly see this error message, it may be worth verifying that the Conversion Service URL is properly configured. This can only be done by D2L support representative.
About exporting course components

You can export components from your course offering to a file. This allows you to reuse these components in another learning management system, including another Brightspace Learning Environment, or to store the components and then re-import them into another course offering or template at a later date.

Components are exported to an IMS-Compliant zip file, a standard file format based on the IMS Content Packaging specification. This means you should be able to reuse these components in any learning management system that supports this format.

You can export course components from the organization level, except for files in the organization or shared files areas.

The following table addresses some common concerns around exporting course components:

<table>
<thead>
<tr>
<th>Concern</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>User privacy might be compromised when exporting course components</td>
<td>User data is not copied. For example, if you copy the discussions component, only the forums and topics are copied, not the posts inside the topics. Similarly, if you copy assignment submissions folders or quizzes, user submissions and quiz attempts are not copied.</td>
</tr>
<tr>
<td>Links and associations between components</td>
<td>Associations between components will not be exported (for example, release conditions). The IMS Content Packaging specification, which the format for export files is based on, does not support these associations.</td>
</tr>
</tbody>
</table>

Export course components

1. In the course offering containing the components you want to copy, on the navbar, click **Course Admin > Import/Export/Copy Components**.
2. Select **Export Components > Start**.
3. In the **Select Components to Export** section, select the check box for any components you want to export. To export only certain items from a component, choose **Select individual items to import**.
4. Click **Continue**.
5. If you chose **Select individual items to export** for any component in the previous step, the Select Items page appears. This page lists all of the items and any sub-items contained in the current component. Otherwise, the Confirm Components to Export page appears. To view sub-items, click the + **Expand** icon next to an item. Select the individual items and sub-items you want to export and click **Next**. When you have finished selecting individual items from components, the Confirm Components to Export page appears.
6. Click **Continue**.
7. When the export process ends, click **Finish**.

© 2017 by D2L Corporation. All rights reserved.
8. Click the Click here to download the export Zip package link. If you do not download the file from this screen, it is lost. You cannot download it later.

What course components can be exported?

- Assignments
- Calendar
- Checklist
- Competencies
- Content
- Course files
- Discussions
- External links
- FAQ
- Glossary
- Grades (except calculated grade items)
- Navbar templates (not navbars)
- Announcements
- Question Library
- Quizzes
- Rubrics
- Self Assessments
- Surveys
IMS Common Cartridge

About IMS Common Cartridge
The IMS Common Cartridge standard allows publishers and content providers to create platform-independent packages of resources (content, assessments, question libraries, discussions, etc.) building on existing IMS content and QTI quizzing packaging standards. Package creators can optionally protect the package, requiring users to authenticate with the creator using web services before importing or accessing protected resources. Common Cartridge was designed to provide a standard way to package and protect content, as opposed to each publisher or each learning management system creating a proprietary method of protection and enforcement.

For more detailed information on the Common Cartridge project and its role in the Digital Learning Connection, visit the IMS Global Learning Consortium website (http://imsglobal.org).

About importing IMS Common Cartridge packages
You can import IMS Common Cartridge packages and expand your course offerings to include a wide range of innovative, platform-independent, and diverse course content from publishers and content providers.

Importing an IMS Common Cartridge package follows the same process as importing other files of supported import formats. Importing a cartridge automatically creates the applicable content, quizzes, questions, etc. in Brightspace Learning Environment and makes them immediately available for use. Package creators have the option of protecting cartridges on import or forcing the user to enter an access code at the beginning of the import process.

How protected IMS Common Cartridge resources are handled
Any protected resource that imports from an IMS Common Cartridge package displays a Protected icon beside it. When users first try to access a protected resource, they are prompted for an access code, which is distributed by the package creator. Entering the access code and accepting the license agreement initiates the electronic authorization with the package creator’s authorization web service and unlocks the resource for the user.

The user is not prompted to enter their access code when accessing additional protected content from the package until the authorization period ends. The length of the authorization period is determined by the package creator and changes from one package to another. If a course contains protected resources from multiple packages, users are typically prompted for authorization only once per protected package.

Protected resources can be copied between courses, but cannot be exported from Brightspace Learning Environment.

IMS Common Cartridge versions
Brightspace Learning Environment currently supports the following versions of IMS Common Cartridge:

- IMS Common Cartridge 1.0
- IMS Common Cartridge 1.1
- IMS Common Cartridge 1.2
• IMS Common Cartridge 1.3 and IMS Thin Common Cartridge 1.3
The following table provides an overview of each version, including a summary of the features and any other technical details worth noting.

<table>
<thead>
<tr>
<th>IMS Common Cartridge version</th>
<th>Summary</th>
<th>Technical details</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMS Common Cartridge 1.0</td>
<td>In the resource metadata context, includes the higher education value.</td>
<td>The package file should have the extension .zip.</td>
</tr>
<tr>
<td></td>
<td>Contains metadata for the intended user roles: Learner and Instructor.</td>
<td>Cartridge manifest metadata must refer to version 1.0.0.</td>
</tr>
<tr>
<td></td>
<td>These are the user roles that can view the resource.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Contains the intendedUse attribute for Web Content Resources. This attribute must contain one of the following values: lessonplan, syllabus, or unspecified.</td>
<td></td>
</tr>
<tr>
<td>IMS Common Cartridge 1.1</td>
<td>Offers easy support and integration with IMS Learning Tools Interoperability (LTI) v1.0 resources. You can integrate rich learning applications or premium content with platforms or other systems from which applications can be launched, without additional customization.</td>
<td>IMS Common Cartridge 1.1 supports LTI links through Brightspace Learning Environment User Interface, Bulk Course Create (BCC), and Course Import API.</td>
</tr>
<tr>
<td></td>
<td>In the resource metadata context, includes the following values: higher education, school, training, and other.</td>
<td>The package file should have the extension .imscc. This extension helps identify files that are likely to be Common Cartridges.</td>
</tr>
<tr>
<td></td>
<td>Adds metadata for the Mentor intended user role.</td>
<td>Users are notified in the processing logs when the resource is imported successfully; however, their intendedUse type is discounted.</td>
</tr>
<tr>
<td></td>
<td>The intendedUse attribute for Web Content Resources is optional in this Cartridge version.</td>
<td>Cartridge manifest metadata must refer to version 1.1.0.</td>
</tr>
<tr>
<td>IMS Common Cartridge 1.2</td>
<td>Includes metadata for curriculum standards, which provides the option to associate the cartridge, resource, or question item with zero or more curriculum standard identifiers, from one or more providers. Users can use any curriculum standard, provided that it supports unique identifiers. The intendedUse attribute for Web Content Resources offers a new attribute called Assignment.</td>
<td>Curriculum standards metadata is recognized in v1.2, but is not supported by Brightspace Learning Environment. As a result, it is discounted, and users are instead notified in the processing logs whether their data was imported successfully. Common Cartridge specification has deprecated authorization to the Course Import workflow. D2L still supports it, but recommends that users use Learning Tools Interoperability (LTI) links to access remote/secure content. Cartridge manifest metadata must refer to version 1.2.0.</td>
</tr>
<tr>
<td>IMS Common Cartridge 1.3</td>
<td>Allows you to import multiple question banks within a single cartridge. Provides the ability to specify Common Cartridge XML descriptions within an imsmanifest.xml file, which are imported by Brightspace Learning Environment. Provides the option to add metadata to LTI links. In Brightspace Learning Environment, this metadata is incorporated into the content topic so that it can point to the LTI link.</td>
<td>Question banks have no titles, so they are categorized as &quot;Section 1&quot;, &quot;Section 2&quot;, and so on, in Brightspace Learning Environment. Question banks can be translated into any language that D2L supports. For multiple imports of multiple question banks, section numbering does not increment; it is constrained to the number of banks within the package. For example, if users import a package containing two question banks, and then again with only a single question bank, the following occurs:</td>
</tr>
</tbody>
</table>

Multiple question banks in a question library

The following new features are not entirely supported by Brightspace Learning Environment:

- ePub3, Interactive Whiteboard (IWB) and Accessible Portable Item Profile (APIP) file extensions for resources
- Other unknown extensions for resources

Brightspace Learning Environment imports files with these extensions into the Manage Files tool, but does not create a content topic because the content type is not currently supported in the application. Users will receive a message about this in the processing logs.

Cartridge manifest metadata must refer to version 1.3.0.
For more information about the latest versions of IMS Common Cartridge that are supported in Brightspace Learning Environment, see the March 2015 (https://community.brightspace.com/resources/documentation/release_notes_201503) and April 2015 (https://community.brightspace.com/resources/documentation/release_notes_201504) release notes on the Brightspace Community. Also, to view IMS official specs on Common Cartridge for each version, click the following:

- **IMS Common Cartridge 1.0** (http://www.imsglobal.org/cc/ccv1p0/imscc_profilev1p0.html)
- **IMS Common Cartridge 1.1** (http://www.imsglobal.org/cc/ccv1p1/imscc_profilev1p1-Overview.html)
- **IMS Common Cartridge 1.2** (http://www.imsglobal.org/cc/ccv1p2/imscc_profilev1p2-Overview.html)
- **IMS Common Cartridge 1.3** (http://www.imsglobal.org/cc/ccv1p3/imscc_Overview-v1p3.html) and **IMS Thin Common Cartridge 1.3** (http://www.imsglobal.org/cc/ccv1p3thin/ims_thinCC_impl-v1p3.html)

### Mobile Branding Administration

**About Mobile Brand Administration**

Use the Mobile Brand Administration page to customize the look and feel of your institution's Mobile Web interface. You can customize the colors and logo in the interface to match your organization's branding or modify the appearance of titles and headings to help users identify courses more easily.

Customizing branding at the organization level establishes the default settings for the org and all org units; child org units do not receive default settings from their parent org units. If you customize any setting at the org unit level, all settings become custom to that org unit. This means that future changes to the organization branding will not transfer or overwrite settings in an org unit with custom branding (unless you restore defaults).

**Update mobile branding**

1. Do one of the following:
   - To update mobile branding for the organization, from the Admin Tools menu, click Mobile Brand Administration.
   - To update mobile branding for an org unit, click Course Admin > Mobile Brand Administration.

2. Make your changes.

3. Click Save.
**Mobile branding reference sheet**

Depending on whether you access the Mobile Brand Administration page from the organization or org unit level, you may not have access to all settings.

The Mobile Web navbar does not reproduce settings from the Navbar tool.

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Background</td>
<td>Sets the color that appears behind main content interface elements.</td>
<td><img src="example-background.png" alt="Background Image" /></td>
</tr>
<tr>
<td>Link Color</td>
<td>Sets the color of system links.</td>
<td><img src="example-link-color.png" alt="Link Color Example" /></td>
</tr>
</tbody>
</table>

<p>| <strong>Navbar</strong> |                                                                 |         |
| Logo Image | Sets the image that appears at the top of every screen on the navbar. Use this option to tailor your Mobile Web navbar to match your institution's logo or crest. The dimensions of your image should be no larger than 200 x 50 pixels to fit correctly on mobile screens. | <img src="example-logo.png" alt="Logo Image Example" /> |</p>
<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fill Type</td>
<td>Sets the type of background for the navbar area. You can choose between a solid or gradient background. Once you select the fill type, corresponding color options appear.</td>
<td><img src="image" alt="Navbar Example" /></td>
</tr>
</tbody>
</table>

**Page Title**

| Fill Type | Sets the type of background for the page title bar. You can choose between a solid or gradient background. Once you select the fill type, corresponding color options appear. | ![Page Title Example](image)                                                                 |
| Border Color | Sets the color of a thin border on the bottom of the page title area. | ![Border Color Example](image)                                                                 |
| Text Color | Sets the color of the page title text. | ![Text Color Example](image)                                                                 |

**Headings**

| Fill Type | Sets the type of background for the heading bar. You can choose between a solid or gradient background. Once you select the fill type, corresponding color options appear. | ![Heading Example](image)                                                                 |
| Border Color | | ![Border Color Example](image)                                                                 |
| Gradient Start Color | | ![Gradient Start Color Example](image)                                                                 |
| Gradient End Color | | ![Gradient End Color Example](image)                                                                 |
| Text Color | | ![Text Color Example](image)                                                                 |
### Area | Description | Example
--- | --- | ---
Border Color | Sets the color of a thin border on the top and sides of the heading area. |  
Text Color | Sets the color of the heading text. |  

### Subheadings

| Fill Type | Sets the type of background for the subheading bar. You can choose between a solid or gradient background. Once you select the fill type, corresponding color options appear. |  
| Border Color | Sets the color of a thin dotted border on the bottom of the subheading area. |  
| Text Color | Sets the color of the subheading text. |  

---

## Learning Tools Interoperability: Content-Item Message Service 1.0

Content-Item Message is an LTI service that allows instructors to insert third party content into Brightspace Learning Environment using a standard integration that your administrator needs to set up prior to your usage. Placements represent locations in Brightspace Learning Environment, in which you can access the integrated third party tool and insert its content. Supported placements include Content > Existing Activities, and within the HTML Editor tool > Insert Stuff, and Insert Quicklink.
Add third-party content from the Content tool
1. In Content, from the Existing Activities drop-down list, select the third party tool you want to add content from.
2. In the Add Activity dialog box, select and insert the content you want to add into your course. These topics appear as content topics in your course.

Add third-party content from Insert Stuff
1. In the HTML Editor, click the Insert Stuff icon.
2. Under Insert Stuff, select the tool that you want to select content from.
3. Select and insert the content you want to add into your course.
4. Preview the selected content and click Insert.

Add third-party content from Insert Quicklink
1. In the HTML Editor, click the Insert Quicklink icon.
2. In the Third Party section, select the tool you want to add content from. The selected content is added into the HTML Editor as a Quicklink.

Add third-party content from Course Import
1. In Content, click Table of Contents.
2. From the Import Course drop-down list, select the third-party tool containing the content you want to add.
3. In the Import Course Package dialog box, select the course package you want to add into your course.
4. Click Import All Components.
5. Click View Content.

Add third-party content from Import/Export/Copy Components
1. From the Admin Tools menu, click Import/Export/Copy Components.
2. Select the Import Course from External Learning Tool radio button and select the third-party content provider you want to use to import course content.
3. Click Start.
4. In the Import Course Package dialog box, select the course package you want to add into your course.
Metadata basics

What is metadata?
Metadata is information about a learning resource that you add to the resource to help other users locate it and understand its purpose.

Administrators can create views, templates, and taxon schemas for your organization to enable users to enter repetitive metadata information quickly and consistently.

Metadata and the Content tool
You can add and edit metadata for content modules and topics when you publish them to Brightspace Learning Repository. You can also add metadata to content modules and topics from directly within the Content tool.

Metadata and the Brightspace Learning Repository tool
You can search for learning resources (objects and files) based on their metadata from within a Brightspace Learning Repository (LOR), and you can view an object’s metadata to determine whether it suits your needs before you import it into a course. Depending on your permissions, you can also edit the learning object’s metadata. Organizations can also require adding metadata when publishing a learning object to an LOR and can specify a set of required metadata that is mandatory for learning objects.

Metadata interfaces
There are two interfaces that you can use to enter metadata:

- **Basic interface** - The basic interface presents a simple list of fields grouped into categories. Users cannot specify a language for their values or enter values in multiple languages, nor can they add additional values to a field (although they can configure a view to display a field multiple times in the basic interface, enabling users to enter multiple values).

- **Advanced interface** - The advanced interface enables users to specify their language, enter values in multiple languages, and enter multiple values for some fields. If a view is part of the IEEE LOM family, its fields display as a hierarchy in the advanced editor.

Best practices for using metadata
- If you want to only see category names instead of all of the fields in every category, enable the basic interface. If you choose to only display the category names, you can still show the fields in the first category by default.
• If you want to use a template, import metadata, or copy metadata from another resource, do so before manually entering data. Any data you enter manually is erased when you apply existing metadata from another source.

• In some fields, you may need to enter more than one value; for example, if a resource has multiple keywords or multiple authors/contributors. In the basic interface, if a field accepts multiple values, it is listed multiple times. In the advanced interface, you can manually add additional values to a field and then enter data for the additional values. Each value can have multiple translations in different languages.

• If another resource in your course has similar metadata, you can copy that resource’s metadata and then modify it, rather than re-entering all of the information.

• Views within the same family provide different ways of looking at (or entering) the same metadata, but views in different families provide access to different metadata. Keep this in mind when you determine what views to make available to users in your organization.

• Switching views can lead to conflicts and will cause you to lose unsaved changes. Avoid switching views where possible.

• Use a standard naming convention for templates in your organization.

• Use replace strings to add dynamic information to a template.

• If you want to specify the language of your metadata and enter data for a single field in multiple languages, use the advanced interface.

**Troubleshooting metadata conflicts**

Conflicts occur when a resource’s metadata violates restrictions set by the current view. You might encounter a conflict when you:

- Switch between views
- Switch from the advanced interface to the basic interface
- Apply a template
- Import metadata
Using metadata views

Metadata views
A view is a collection of fields. A field corresponds to one piece of data that you enter as part of a metadata object. For example, title, description, author, date created, and rights are all possible fields. Different views enable users to see and modify different fields when looking at metadata.

Brightspace Learning Environment includes six base metadata views that implement widely used metadata standards:

- **Dublin Core** ([http://dublincore.org/documents/](http://dublincore.org/documents/)) - This view categorizes metadata using 15 different elements: contributor, coverage, creator, date, description, format, identifier, language, publisher, relation, rights, source, subject, title, and type.
- **GEM** - This view categorizes metadata using 9 different elements: general, life cycle, meta-metadata, technical, educational, rights, relation, annotation, and classification.
- **IEEE LOM** - This view categorizes metadata using the 15 Dublin Core elements, plus 7 additional elements: audience, cataloging, duration, essential resources, pedagogy, quality, and standard.
- **Normetic** ([http://www.normetic.org/](http://www.normetic.org/)) (French) or [http://www.normetic.org/-English-.html](http://www.normetic.org/-English-.html) (see [http://www.normetic.org/-English-.html](http://www.normetic.org/-English-.html)) -
http://www.normetic.org/-English-.html) (English)) - This view is a French version you can use to categorize metadata based on the IEEE LOM view.

- **Object Publishing** - This view categorizes metadata based on a simplified Dublin Core view using 3 different elements: title, description, and keywords.

- **Object Publishing IEEE LOM** - This view categorizes metadata based on a simplified IEEE LOM view using 3 different elements: title, description, and keywords.

Default system views refer to any of the views that ship with Brightspace Learning Environment by default.

Brightspace Learning Environment also includes two default system views that inherit from the IEEE LOM base view:

- **CanCore** (http://cancore.tru.ca/en/)
- **Asset Metadata**
Create a metadata view

Creating a new metadata view may be necessary for any number of reasons. For example, you might require a view for a specific department to refine the general organization’s view, or a simplified view for users who do not require access to all of the metadata associated with your organization’s resources.

You can create new views based on any of the available views, including views you have previously created. When creating a new view, you can rename, reorganize, and hide fields, change field types, and set data restrictions; however, you cannot add additional fields or radically alter the structure of the base view.

Some of the fields in IEEE LOM and Dublin Core are cross-walked, meaning the values from those fields automatically synchronize between the two views. In fields that are not cross-walked, the values entered in a view from one family are not visible across families.

Keep this in mind when you determine what views to make available to users in your organization. Views within the same family provide different ways of looking at (or entering) the same metadata, but views in different families provide access to different metadata.

![Diagram](image)

Figure 1: This diagram summarizes the relationships between views and which views can access data entered through other views.

1. From the Admin Tools menu, click Metadata Administration.
2. On the Views page, click New View.
3. Enter a View Name.
4. From the Parent View drop-down list, select the parent view that contains the structure that you want your view to inherit.
5. Do one of the following:
   - If you want your view to inherit its settings from its parent, select Inherit Properties from Parent View.
If you want your view to copy properties from an existing view, select Copy Properties from an Existing View.

6. Click Save.

7. On the Edit View page, using the provided tabs, further customize your General, Restrictions, and Layout options.

8. Click Save.

Import a metadata view
You can add a metadata view by importing an XML file into Brightspace Learning Environment.

Brightspace Learning Environment treats any view that you import as a customized view and maintains the language terms defined in the org unit that the view comes from. For example, if a French org defines a view with French terms and exports the view, then when you import the view in another org unit, users see the French terms even if they are using English.

1. From the Admin Tools menu, click Metadata Administration.
2. On the Views page, from the More Actions button, click Import View.
3. On the Import View page, enter a View Name.
4. To select the view that you want to import, click Browse. Locate your file and click Open.
5. Click Import.

Export a metadata view
You can export a metadata view as an XML file. When you export a metadata view, it retains the language terms that you have in your org unit. For example, your French org defines a view with French terms and exports the view, then when other users import the view in another org unit, they see the French terms even if they are using English.

1. From the Admin Tools menu, click Metadata Administration.
2. On the Views page, from the More Actions button, click Export View.
3. From the Export View drop-down list, select the view you want to export.
4. Click Export.

Using metadata languages

Set initial metadata language
The initial language serves two purposes: All the metadata you enter through the basic interface is associated with the initial language and the initial language is selected by default for values entered through the advanced interface.

1. From the Admin Tools menu, click Metadata Administration.
2. On the **Metadata Languages** page, in the **Actions** column for the language you want to set as default, click the **Set Initial Language** icon.

**Add a metadata language**

You can add a language for users in metadata fields. This enables users, when publishing a content topic, to enter multiple descriptions for the topic in different languages. For each language variant, users specify the language they use from the choices available.

1. From the **Admin Tools**, click **Metadata Administration**.

2. On the **Metadata Languages** page, from the **Select a Language** drop-down list, click the language you want to add.

3. If you want to identify regional variations for your chosen language, from the **Select a Country** drop-down list, click the country you want to add.

4. Click **Add**.

**Using metadata templates**

**Metadata template types**

Brightspace Learning Environment comes with 4 basic metadata template types:

- Default Template
- Dublin Template
- GEM Template
- IEEE Template

**Create a metadata template**

A template is a collection of predefined values that users can use to quickly add standard metadata to a resource. Templates enable you to quickly apply standard metadata to resources that have duplicate information, saving you from re-entering the same information for each resource.

Templates can include static information that is the same every time a user applies the template and dynamic information based on replace strings that updates when a user applies the template.

For example, if members of an anthropology department are cataloging images of pottery shards from a site, they can use a template to automatically fill in standard data associated with all of the images including the resource type, format, associated keywords, etc.

1. From the **Admin Tools** menu, click **Metadata Administration**.

2. On the **Templates** page, click **New Template**.

3. Enter your **New Template** details.
4. Click **Save**.
5. On the **Edit Template** page, using the provided tabs, further customize your **Properties** and **Values** options.
6. Click **Save**.

**Import a metadata template**

1. From the **Admin Tools** menu, click **Metadata Administration**.
2. On the **Templates** page, from the **More Actions** button, click **Import Template**.
3. On the **Import Template** page, enter a **Template Name**.
4. To select the template that you want to import, click **Browse**. Locate your file and click **Open**.
5. Click **Import**.

**Export a metadata template**

1. From the **Admin Tools** menu, click **Metadata Administration**.
2. On the **Templates** page, from the **More Actions** button, click **Export Template**.
3. From the **Export Template** drop-down list, select the template you want to export.
4. Click **Export**.

**Using metadata taxon schemas**

**What is a taxon schema?**
A taxon is a collection of things grouped together according to their basic similarities. For example, an educational taxonomy may be defined as University > Faculty > Department > Specialties and so on. Schemas define the structure, content, and semantics of documents, and in this case, XML documents. In the context of Brightspace Learning Environment, taxon schemas are classification systems that can be used to categorize resources like learning objects. This enables users to browse for resources in Brightspace Learning Repository organized by categories in defined schemas.

Only views in the IEEE LOM family support taxon schemas. The actual taxon schemas available to a user when entering metadata depend on the view selected. When editing a view, you can specify which of the taxon schemas are available in that view.

By changing a view’s available schemas, you specify the classification systems available to a user when using the view to enter metadata for a resource.

**Taxon schema types**

Brightspace Learning Environment comes with 2 basic taxon schema types:

- Bloom's Taxonomy
Define your taxon schema in an XML file
To add a schema, you must have an XML file that defines the schema. You can use the XML Sample File and the comments in it as a guide to creating your own.

1. From the Admin Tools menu, click Metadata Administration.
2. On the Taxon Schemas page, in the Import a Taxon Path Schema area, click the XML Sample File link.
3. Edit the sample file with an XML or text editor.

Import your taxon schema from an XML file
Once you’ve defined your taxon schema in an XML file, you can import it back into Brightspace Learning Environment.

1. From the Admin Tools menu on the minibar, click Metadata Administration.
2. On the Taxon Schemas page, in the Import a Taxon Path Schema area, enter your schema details.
3. To select the schema you want to import, click Browse. Locate your file and click Open.
4. Click Import.

Intelligent Agents

Intelligent Agents basics

What is the Intelligent Agents tool?
The Intelligent Agents tool monitors an org unit to find activity that matches criteria that you set. The criteria that the agents search for are login activity, course activity, and release conditions in Brightspace Learning Environment.

Example uses for agents include:
- Emailing users with grades below a certain level
- Checking for users that have not logged in within a specific number of days
- Checking for users that view a specific content topic

Considerations for setting up agents
When you create a new agent, you need to determine:
- The criteria the agent looks for. The agent can check login activity, course activity, and attached release conditions.
- The written content in the email that the agent sends when its criteria are met.
- How often the agent takes action when a user satisfies the criteria.
How often the agent is scheduled to run and find users that meet its criteria.

Best practices for creating and using agents
There are many things you should consider when setting up agents for your course in order to get the most benefit from using the tool. Agents are most useful when you have carefully considered how you are organizing and presenting them in a course.

Some best practices include:

- Use a standard naming convention to keep the order and purpose of each agent clear
- Use the agent’s Description area to collect reminder notes of what you need to adjust in the agent for each offering
- Determine if your agent would benefit from repetition
- Use replace strings to personalize emails and minimize editing
- Avoid overusing agents, especially if you can get the information to learners another way
### Replace strings for agents

<table>
<thead>
<tr>
<th>Replace String</th>
<th>Description</th>
<th>For Use In</th>
</tr>
</thead>
<tbody>
<tr>
<td>{InitiatingUser}</td>
<td>The user who performs the action that meets the agent’s criteria</td>
<td>Email address field</td>
</tr>
<tr>
<td>{InitiatingUserAuditors}</td>
<td>The auditors for the user who performs the action that meets the agent’s criteria</td>
<td>Email address field</td>
</tr>
<tr>
<td>{OrgName}</td>
<td>The name of the organization</td>
<td>Email body</td>
</tr>
<tr>
<td>{OrgUnitCode}</td>
<td>The code for the Org Unit</td>
<td>Email body</td>
</tr>
<tr>
<td>{OrgUnitName}</td>
<td>The name of the Org Unit</td>
<td>Email body</td>
</tr>
<tr>
<td>{OrgUnitStartDate}</td>
<td>The start date specified for the Org Unit</td>
<td>Email body</td>
</tr>
<tr>
<td>{OrgUnitEndDate}</td>
<td>The end date specified for the Org Unit</td>
<td>Email body</td>
</tr>
<tr>
<td>{OrgUnitId}</td>
<td>The org unit ID required to make quicklinks works</td>
<td>Email subject line and email body</td>
</tr>
<tr>
<td>{InitiatingUserFirstName}</td>
<td>The first name of the initiating user</td>
<td>Email body</td>
</tr>
<tr>
<td>{InitiatingUserLastName}</td>
<td>The last name of the initiating user</td>
<td>Email body</td>
</tr>
<tr>
<td>{InitiatingUserUserName}</td>
<td>The username of the initiating user</td>
<td>Email body</td>
</tr>
<tr>
<td>{InitiatingUserOrgDefinedId}</td>
<td>The Org Defined ID of the initiating user</td>
<td>Email body</td>
</tr>
<tr>
<td>{LastCourseAccessDate}</td>
<td>The date the initiating user last accessed the course</td>
<td>Email subject line and email body</td>
</tr>
<tr>
<td>{LastLoginDate}</td>
<td>The date the initiating user last logged in</td>
<td>Email subject line and email body</td>
</tr>
<tr>
<td>{LoginPath}</td>
<td>The address of the login path for the site</td>
<td>Email body</td>
</tr>
</tbody>
</table>

### Using agents

**Create an agent**

1. On the navbar, click ![Course Admin](Course Admin).
2. Click ![Intelligent Agents > New](Intelligent Agents > New).
3. On the **Agent List** page, click **New**.
4. In the **Agent Details** area, enter a name and description.

5. If you would like the agent to be active, select **Agent is enabled**.

6. In the **Agent Criteria** area, do one of the following:
   - If you want your agent to target users’ login habits, in the **Login Activity** section, enter your criteria.
   - If you want your agent to target users’ course habits, in the **Course Activity** section, enter your criteria.
   - If you want your agent to run when a specific existing condition has been met in the **Release Conditions** area, click **Attach Existing**. Select the check box for any condition you want to attach. Click **Attach**.
   - If you want your agent to run when a specific new condition has been met, in the **Release Conditions** area, click **Create and Attach**. Select a **Condition Type** from the drop-down list. Complete any additional **Condition Details** that appear and click **Create**.

7. In the **Agent Action** area, do the following:
   - Select how often you want the agent to take action.
   - If you want to schedule how frequently Brightspace Learning Environment evaluates the agent criteria, select the **Use Schedule** check box. Click **Update Schedule** and set your scheduling details.
     
     **Note:** Scheduled intelligent agents stop running and are automatically disabled if the course is inactive, over (end date passed), or deleted. You can still set up a practice run or a manual run of an intelligent agent at any time in a course with a passed end date.
   - In the **Email Format** area, enter your email details.

8. Click **Save and Close**.

**Edit an agent**

1. On the navbar, click **Course Admin**.

2. Click **Intelligent Agents**.

3. From the context menu of the agent you want to edit, click **Edit Agent**.

4. Make your changes.

5. Click **Save and Close**.

**Copy an agent**

You can copy an agent to reuse or make minor editing changes to. All copied agents will be disabled by default.

1. On the navbar, click **Course Admin**.

2. Click **Intelligent Agents**.
3. From the context menu of the agent you want to copy, click **Copy**. A new agent is created and **Copy of** is added to the beginning of its name.

**Delete an agent**

You can delete an agent individually or in bulk. Deleted agents do not run if they have a recurring schedule.

1. On the nav bar, click **Course Admin**.
2. Click **Intelligent Agents**.
3. In the **Agent List**, select the check boxes of the agents you want to delete and click **Delete**.
4. To confirm the deletion, click **Delete**.

**Restore an agent**

You can restore deleted agents. All restored agents maintain existing properties and history.

1. On the nav bar, click **Course Admin**.
2. Click **Intelligent Agents**.
3. In the **Restore Agents** page, click **Restore** to restore any of the deleted agents.

**Update Intelligent Agents settings**

You can adjust the settings in the `<tool_Intelligent_Agent>` tool to set custom values for the name that emails come from and the reply-to address that responses are delivered to.

1. On the nav bar, click **Course Admin**.
2. Click **Intelligent Agents**.
3. Click **Settings**.
4. On the **Intelligent Agents Settings** page, select one of the following:
   - Select **Use the system defaults**.
   - Select **set custom values for this course** and fill in the available fields.
5. Click **Save**.
Run an agent manually
Typically, agents are set up to run automatically. If you do not have a regular schedule set up for an agent, you must run it manually.

When you run an agent manually, it sends a confirmation email to the user that requested or set up the agent. This email contains the following information: org unit code and name, which agent ran, time and date the request was submitted, time and date the request was finished, and whether the agent took action.

You can set up a manual run of an intelligent agent at any time in a course with a passed end date. Agents do not need to be enabled in order to set up a manual run.

1. On the navbar, click [Course Admin].
2. Click [Intelligent Agents].
3. From the context menu of the agent you want to run manually, click Run Now.
4. To confirm the manual run, click Run.

Perform a practice run
You can have an agent perform a practice run to see who will be identified by the agent without sending those users an email. Agents do not need to be enabled in order to perform a practice run.

1. On the navbar, click [Course Admin].
2. Click [Intelligent Agents].
3. From the context menu of the agent you want to perform a practice run for, click Practice Run.
4. To view the users identified, on the Agent List, in the Results of Last Run column, click the link.

Change the status of an agent
You can enable and disable agents individually or in bulk easily on the Agent List page. Disabled agents display an Agent is not enabled icon by their name.

1. On the navbar, click [Course Admin].
2. Click [Intelligent Agents].
3. On the Agent List page, do one of the following:
   - To enable an agent, select the check box for any agent you want to enable and click the [Enable] link.
   - To disable an agent, select the check box for any agent you want to disable and click the [Disable] link.
View the history of an agent
You can view the history of an agent to see when the agent was run, who was identified, the type of run (Manual, Scheduled, or Practice), who ran the agent, and if any errors were encountered.

1. On the navbar, click Course Admin.
2. Click Intelligent Agents.
3. From the context menu of the agent you want to view the history of, click View History.

View scheduled agents' run time
You can view the time of day the scheduled agents will run.

1. On the navbar, click Course Admin.
2. Click Intelligent Agents.
3. Click Settings.

View an agent's next run date
You can view the next run date for scheduled agents. There is no next run date if a schedule is not enabled.

1. On the navbar, click Course Admin.
2. Click Intelligent Agents.
3. On the Agent List page, view the Next Run Date.

Registration

About Self Registration
The Brightspace Learning Environment Self Registration tool allows users to enroll themselves in courses that have the self registration feature enabled. You can define whether self registrations require your approval for users to be enrolled in your course.

If your organization has the Self Registration tool set up, Brightspace Learning Environment users can access a list of all offered courses that allow self registration by clicking the Self Registration link on the My Home page navbar. Users can then register by clicking on the name of the applicable course and filling out the associated registration form.

You can allow only users that have Brightspace Learning Environment accounts (existing users) to self-enroll in your course or allow both existing and new users (external users) to self-enroll in your course. If you allow external
registration, a Self Registration link appears on your organization’s Brightspace Learning Environment login page to allow new users to complete course enrollment.

Create new Brightspace Learning Environment users using the Self Registration tool
1. On the course home page, click Course Admin.
2. Click Self Registration.
3. On the Registration List page, click Add Participant.
4. Select the Create and add a new participant option.
5. In the Enrollment Options area, do any of the following:
   - To require the user to change their password upon logging into the course for the first time, select Force password change on login.
   - To send an email to the user confirming their enrollment, select Send an enrollment email.
6. In the Create User area, enter your user details.
7. Click Enroll.

Enroll existing Brightspace Learning Environment users using the Self Registration tool
1. On the course home page, click Course Admin.
2. Click Self Registration.
3. On the Registration List page, click Add Participant.
4. Select the Add an existing participant option.
5. In the Lookup Participant area, enter all or part of a user’s name, username, or email address. Click Search.
6. Select the users you want to enroll. In the Role column, from the drop-down list, assign the selected users a role.
7. Click Enroll.
Enable self registration in a course offering

An administrator must enable the necessary configuration variables and security permissions and the Self Registration tool must be turned on in order for you to enable self registration in a course offering.

1. On the course home page, click Course Admin.
2. Click Course Offering Information.
3. On the Course Offering Information page, in the Registration area, select Users can self-register.
4. Click Save.

Unenroll users from a course offering using the Self Registration tool

Unenrolling a user from a course offering in the Self Registration tool will only remove the user from your course, not from Brightspace Learning Environment.

1. On the course home page, click Course Admin.
2. Click Self Registration.
3. On the Registration List page, select every user you want to unenroll.
4. Click the Reject Selected icon.

Import users using the Self Registration tool

The Import Participants page contains file formatting information for your import package, as well as a sample file you can download and repurpose.

When importing an extremely large number of users (files containing 1000 or more users) you might receive a timeout error. If this occurs, contact your site administrator; they can use the Bulk User Management tool to import the users.

1. On the course home page, click Course Admin.
2. Click Self Registration.
3. On the Registration List page, click Import Participant.
4. In the Import Participants area, do any of the following:
   - To require the user to change their password upon logging into the course for the first time, select Force password change on login.
To send an email to all users who are not already Brightspace Learning Environment users to confirm their enrollment, select **Send email to new users**.

To send an email to all users who are already Brightspace Learning Environment users to confirm their enrollment, select **Send email to existing users**.

5. In the **File** area, click **Browse**. Locate your .csv or .txt file and click **Open**.

6. Click **Import**.

### Run Self Registration reports

1. On the course home page, click **Course Admin**.

2. Click **Self Registration**.

3. On the **Registration List** page, click **Report**.

4. In the **Search Options** area, do the following:
   - Select the **From** and **To** dates you want to report on.
   - Select **Show Self-Registrations only**.

5. Click **Generate Report**.

### Create registration forms

A registration form contains fields that users must fill in when registering for a course.

1. On the course home page, click **Course Admin**.

2. Click **Self Registration**.

3. On the **Registration List** page, click **Form > New Form**.

4. Enter a **Form Name**.

5. Click **Save Form**.

6. Do any of the following:
   - To add a system field to the form, click **Add System Field**.
   - To add a custom field to the form, click **Add Custom Field**.
   - To change the order in which fields appear, click **Reorder Fields**.
   - To determine if the field requires a response, select or clear the **Required** check box for the field.

7. Click **Save Form**.
Associate a registration form with a course

A course must have an associated registration form before you can list it on the Self Registration page. You can view information gathered from completed registration forms on the Registration Report page.

If a course does not have an associated registration form, a warning appears on the Course Offering Information page.

1. On the course home page, click Course Admin.
2. Click Self Registration.
3. On the Registration List page, click Form.
4. On the Registration Form page, in the Course Offering Forms area, select the form you want to associate.
5. Click Save.

Set restrictions on self registration

The Registration Restrictions page allows you to set date restrictions for enrollment and specify the maximum number of registrations you will accept, as well as any prerequisite or anti-requisite courses.

1. On the course home page, click Course Admin.
2. Click Self Registration.
3. On the Registration List page, click Restrictions.
4. Do any of the following:
   - To restrict registration to certain dates, select Registration Start Date and Registration End Date and enter a date range using the drop-down lists. The course only appears for users on the Self Registration page during the window of time you specify, although courses are always visible for users with cascading permissions.
   - To restrict registration to a number of participants, enter the number of allowed registrations in the Self Registration Limit field. This field is compared against the number of users that have self-registered and have an enrollment status of either approved or unassessed.
   - To add prerequisite courses, click Add Prerequisites. Locate the group of org units or specific org units you want to add. Click Add.
   - To add anti-requisite courses, click Add Excluded Enrollments. Locate the group of org units or specific org units you want to add. Click Add.
5. Click Save.
Approve self registrations
To approve self registration enrollments, you must have the Approve Enrollments permission.

1. On the course home page, click Course Admin.
2. Click Self Registration.
3. On the Registration List page, from the Show drop-down list, click All unassessed users > Search.
4. Select every user you want to approve and click the Approve Selected icon.

Delete or reject self registrations
When you delete a self registration request, the user is permanently removed from the list and is not enrolled in the course. When you reject a self registration request, the user remains on the list but is not enrolled in the course.

1. On the course home page, click Course Admin.
2. Click Self Registration.
3. On the Registration List page, do one of the following:
   - To delete a registration request, select the check box for any user you want to delete and click the Delete Selected icon.
   - To reject a registration request, select the check box for any user you want to reject and click the Reject Selected icon.
Troubleshooting self registrations

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>My registration form is not displaying on the Self Registration page</td>
<td>Create and associate a registration form with your course</td>
</tr>
<tr>
<td>I want to use the same registration form in multiple courses without</td>
<td>Create a standard registration form at the organization level</td>
</tr>
<tr>
<td>recreating it every time</td>
<td></td>
</tr>
<tr>
<td>I can't approve self registrations</td>
<td>Make sure you have the appropriate security permissions</td>
</tr>
<tr>
<td>I can't reject or delete self registrations</td>
<td>Ensure your role has the Manage Courses &gt; Unenroll Users from the</td>
</tr>
<tr>
<td></td>
<td>Registration Area permission for the course offering level</td>
</tr>
<tr>
<td>I can't enable self registration in a course offering</td>
<td>Ensure the Self Registration tool, necessary configuration variables,</td>
</tr>
<tr>
<td></td>
<td>and security permissions are enabled</td>
</tr>
<tr>
<td>I can't find my course on the Self Registration page</td>
<td>Make sure that your course has not reached its enrollment limit or</td>
</tr>
<tr>
<td></td>
<td>registration end date</td>
</tr>
</tbody>
</table>

Replace Strings

Replace strings, sometimes referred to as display configuration variables, are configuration variable names enclosed in curly braces {} that are automatically replaced by the corresponding configuration variable values. For example, if you enter the text {OrgUnitID} into a document, when you view the document you will see the Organization Unit ID (ou #) of the course.

Replace strings are used in all tools that use HTML Editor. However, evaluation rules for the replace strings vary with the tool as follows:

- For the Content tool, curly braces are stripped even if the string is not a valid configuration variable or a replace string that does not apply to the Content tool. Then, replace strings are evaluated only once when first entered. Thereafter, there is no record of a replacement string having been entered. For example, if you enter {OrgUnitID} into a Content topic in course 'A' and later copy that topic into course 'B', the ou # of course 'A' course will display in the topic in course 'B'.
For all other tools, any curly braces are NOT stripped if the string is not a valid configuration variable or a replace string that does not apply to the tool. Then the replace string is evaluated each time the document containing the replace string is viewed. For example, if you enter \{OrgUnitID\} into a Discussion topic in course 'A' and later copy that topic into course 'B', the ou # of course 'B' will display in the post in course 'B'.

- Not all replace strings apply to all tools as described below.

Replace strings are particularly useful within the following:

- Course Homepage Widgets
- Custom Navigation Bar Links
- Navigation Bars
- Mail Templates

For example, if the text \{UserName\} is in the code of a custom widget for a course home page, users in that course will see their user names displayed.

The available replace strings are:
### Organization replace string

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID number of the organization</td>
</tr>
<tr>
<td>Name of the organization</td>
</tr>
</tbody>
</table>

### Org Unit replace string

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID number of the organization unit</td>
</tr>
<tr>
<td>Name of the organization unit</td>
</tr>
<tr>
<td>Code for the organization unit</td>
</tr>
<tr>
<td>ID number of the type of the organization unit</td>
</tr>
<tr>
<td>Path to files for the organization unit</td>
</tr>
</tbody>
</table>

### User replace string (Unavailable in the Content tool)

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID number of the user. This value is used internally by the system</td>
</tr>
<tr>
<td>Full name of the user or the username entered to log on</td>
</tr>
<tr>
<td>Organization ID. This is an identifier specified by the campus for the user</td>
</tr>
<tr>
<td>First name of the user</td>
</tr>
<tr>
<td>Last name of the user</td>
</tr>
<tr>
<td>User’s internal email address</td>
</tr>
<tr>
<td>User’s external email address</td>
</tr>
<tr>
<td>User’s internal email address</td>
</tr>
</tbody>
</table>
### Role replace string (Unavailable in the Content tool)

<table>
<thead>
<tr>
<th>Role ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{RoleId}</td>
<td>Internal ID number for user’s role</td>
</tr>
<tr>
<td>{RoleCode}</td>
<td>Code for user’s role</td>
</tr>
<tr>
<td>{RoleName}</td>
<td>Name of user’s role</td>
</tr>
</tbody>
</table>

### Mail Template replace string

<table>
<thead>
<tr>
<th>Help Desk ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{HelpDeskEmail}</td>
<td>Email address of the Help Desk</td>
</tr>
<tr>
<td>{HelpDeskName}</td>
<td>Name for the Help Desk</td>
</tr>
<tr>
<td>{LoginPath}</td>
<td>URL of the login path for this site</td>
</tr>
<tr>
<td>{PasswordResetLink}</td>
<td>Link for users to reset their passwords</td>
</tr>
</tbody>
</table>
SCORM

About SCORM

SCORM stands for Sharable Content Object Reference Model. It is a collection of standards that outlines how online learning materials and learning management systems should interact with one another. For additional details, visit: http://scorm.com/scorm-explained/. If you are using the existing Brightspace SCORM solution and have Brightspace Learning Repository for your organization, you can save a SCORM object in the LOR and share it out to multiple courses. This allows you to reuse SCORM objects in multiple locations while saving space in each course. Be aware that the LOR does not support publishing SCORM 2004 content directly from your computer.

In order to use the new SCORM solution, you must enable the Content Service for your organization. If you do not enable the Content Service, your organization will continue to use the existing SCORM solution. If you set up and want to use the new SCORM solution, store SCORM objects directly in Brightspace Learning Environment, and not in Brightspace Learning Repository. You then add SCORM objects directly into the content module you want them to reside in, either by uploading new objects, or selecting from stored objects you had previously uploaded. You can still link objects to multiple courses using dynamic or static linking as you could before, and you can use Import/Export/Copy Components to propagate a part of or a whole course containing SCORM objects to another course in Brightspace Learning Environment.

Brightspace Learning Environment is SCORM 1.2 and SCORM 2004 compliant. SCORM can be used with mobile devices, provided the SCORM object has been developed to work on mobile devices. Access the non-mobile version of your site to make best use of the SCORM object.

For additional technical details about SCORM, visit: http://scorm.com/scorm-explained/technical-scorm/ (see SCORM explained - http://scorm.com/scorm-explained/technical-scorm/). Because each authoring tool may interpret SCORM standards differently, consider viewing any SCORM-related documentation resources provided by your third party authoring tool.

For an external SCORM testing tool, visit: https://code.google.com/p/scormtester/ (see Scorm tester - https://code.google.com/p/scormtester/).

Add a SCORM package to the Content tool

If you are using the new SCORM solution, upload SCORM packages directly into the Content tool.

1. In Content, either create or select a module to include your SCORM package in.
2. Within your selected module, from the Upload/Create button, select New SCORM Object.
3. In the New SCORM Object dialog window, do one of the following:
   - If you want to upload a new SCORM package, click Upload. Then, either browse to your file, or drag and drop it into the designated area.
If you want to add a previously uploaded SCORM package, select it from the list.

4. Click **Save**.

5. On the **Insert SCORM Package** screen, do one of the following:
   - If you want the SCORM package in your course to remain as it was when you uploaded it (to be statically linked), click **Display this version even if a new version is added**.
   - If you want the SCORM package in your course to remain updated as new versions are added (to be dynamically linked), click **Always display the latest version**.

6. Click **Save**.

If you are using the existing SCORM solution, SCORM packages must be imported to the Content tool. The import function identifies the content as SCORM, and allows the proper initialization of SCORM LMS calls.

1. From **Edit Course**, click **Import/Export/Copy components > Import Components**.
2. Select **from a course package**.
3. Click **Start**.
4. Drag and drop the SCORM package onto the upload target.
5. Click **Import All Components**.
6. Do one of the following:
   - To view the SCORM package within Content, click **View Content**.
   - To import another SCORM package, click **Import Another Package**.

**Move your imported SCORM content to a different module**

If you are using the existing SCORM solution and you import a SCORM package, it creates a single module and topic as part of the process. After the import process is completed, you can move the topic using the move function in the Content tool to the desired module and delete the unnecessary module that was created as part of the import process.

**Adjust the display size of your SCORM object**

If you are using the existing SCORM solution, in many cases, display issues are the result of settings selected when authoring a SCORM package. If SCORM objects are too small or too large when viewed in Content, consider replacing the absolute values set for the dimensions in the HTML file with relative values.

1. From **Manage Files**, click the action menu for the file you want to edit.
2. Select **Edit File > HTML Source Editor**.
3. Replace the absolute values for width and height in the HTML file with relative values.
4. Click **Save**.

**Note:** The location of these elements vary depending on the authoring tool used to create the SCORM package. Editing these values from the publishing tool and creating a new package with the updated values allows you to successfully use the package repeatedly while only needing to edit it once.

## Remove a grade item from a SCORM object after the package is imported

In order to remove a grade item that was originally created as part of a SCORM package, you must first break the association between the grade book item and the content item.

1. In the **Content** tool, navigate to the SCORM object that you want to disassociate from the grade item.
2. Click the content topic.
3. From the **Activity Details** tab, in the **Assessment** area, click the topic title.
4. From the context menu, click **No Grade**.
5. Click **Save**.

**Note:** If the SCORM package is already deleted, you cannot remove the grade book item. If you require grade book items to be removed from your course, contact D2L Support.

## Publish a SCORM package as a SWF or HTML5 file with automatic grade creation

If you are using the existing SCORM solution, to ensure that SCORM packages publish as SWF and HTML5 files with automatic grade creation, the `d2l.Tools.Content.AllowAutoSCORMGradItem` configuration variable must be set to **On** (the default for this variable). This configuration variable is an org unit level variable, allowing you to configure SCORM grade item creation differently across your organization.

If you are using SCORM 1.2, the user grades are set when the following occurs:

- The `cmi.core.score.raw` value is set
- The value for `cmi.core.score.max` is not null and is greater than zero
- The SCO Terminate call (LMSFinish) is made

If you encounter errors in your imported SCORM package, test your SCORM package using an external SCORM testing tool such as: https://code.google.com/p/scormtester/ (see Scorm tester - https://code.google.com/p/scormtester/).
Publish a SCORM package as a SWF or HTML5 file with manual grade creation

If you are using the existing SCORM solution, to ensure that SCORM packages publish as SWF and HTML5 files with manual grade creation, the `d2l.Tools.Content.AllowAutoSCORMGradeItem` configuration variable must be set to Off for the Org Unit requiring manual grade creation.

If you are using SCORM 1.2, user grades are set when the following occurs:

- The cmi.core.score.raw value is set
- The value for cmi.core.score.max is not null and is greater than zero
- The SCO Terminate call (LMSFinish) is made

These items are set when the SCORM package is authored and are not determined by Brightspace Learning Environment. If you encounter errors in your imported SCORM package, test your SCORM package using an external SCORM testing tool such as: https://code.google.com/p/scormtester/ (see Scorm tester - https://code.google.com/p/scormtester/).

Troubleshooting

My SCORM objects are too small or too large in the Content tool

In many cases, display issues are the result of settings selected when authoring a SCORM package. If SCORM objects are too small or too large when viewed in Content, consider replacing the absolute values set for the dimensions in the HTML file with relative values. To do this:

1. From Manage Files, click the action menu for the file you want to edit.
2. Select Edit File.
3. Click HTML Source Editor.
4. Replace the absolute values for width and height in the HTML file with relative values.
5. Click Save.

Note: The location of these elements vary depending on the authoring tool used to create the SCORM package. Editing these values from the publishing tool and creating a new package with the updated values allows you to successfully use the package repeatedly while only needing to edit it once.
The top of my SCORM objects are being cropped in the Content tool

The `d2l.Tools.Content.ContentIFrameHeight` configuration variable can be set to constrain the height of the iframe container so that SCORM objects are not cropped when viewed in Content.

To set this configuration variable:

1. From the Admin Tools menu, click Config Variable Browser > Tools > Content > ContentIFrameHeight.
2. Click Add Value.
3. Enter or select the Org Unit ID for which you want to modify the iframe height.
4. Enter the new pixel value you want to set for the iframe.
5. Click Save.

Note: Modifying this configuration variable modifies the height of the iframe container for all content displayed within a given org unit. If you are using other content types in addition to SCORM packages, consider modifying the SCORM package instead.

When I view my SCORM package in the Content tool, I receive a notification that an error occurred initializing communications with the LMS

Some authoring tools include a multiscreen.html file in SCORM packages that requires editing prior to importing the package into Brightspace Learning Environment. To edit the file:

1. Open the SCORM package ZIP folder.
2. Locate the multiscreen.html file.
3. Open the file in an editor.
4. Locate the onload parameter of the <frameset> tag.
5. Replace the current value with: `onload=""`.
6. Locate the src parameter of the <frame> tag.
7. Update the src value with the appropriate .htm file. For example, if the project name is VRT – Tool Intro, there should be an htm file in the SCORM package called `VRT – Tool Intro.htm`. In this example, the src parameter would be: `src="VRT – Tool Intro.htm"`.
8. Save your changes.
9. Place the file back in the ZIP folder, overwriting the original.
10. Import the SCORM package into Brightspace Learning Environment using the Import/Export/Copy Components tool.
An error appears when I close the window that opened to play my SCORM package
Depending on your authoring tools, and if you are using the existing SCORM solution, you might have an option to open the player in a new window. Deselect any options that cause the player to open in a new window and export your SCORM object again.

An "LMSSetValueError:cmi.core.lesson_status to [unknown] Incorrect Data Type" error appears when I open my SCORM object
There is an issue with your SCORM object export. The lesson status action is hard-programmed in the export with a value that is not an accepted value option. Open the SCORM package and search for "unknown". If you find it in an .html file, open the file and replace "unknown" with "completed".
About D2L

A global leader in EdTech, D2L is the creator of Brightspace, the world’s first integrated learning platform.

The company partners with thought-leading organizations to improve learning through data-driven technology that helps deliver a personalized experience to every learner, regardless of geography or ability. D2L’s open and extensible platform is used by more than 1,100 clients and almost 15 million individual learners in higher education, K–12, healthcare, government, and the enterprise sector—including Fortune 1000 companies.

The company has operations in the United States, Canada, Europe, Australia, Brazil, and Singapore.


Contact Us

Phone: 1.519.772.0325 (Worldwide)

Toll Free: 1.888.772.0325 (North America)
           0.808.234.4235 (United Kingdom and Europe)
           0.800.452.069 (New Zealand)
           1.800.656.210 (Australia)
           0.800.891.4507 (Brazil)

Fax: 1.519.772.0324

Email: info@brightspace.com

Twitter: @Brightspace


© 2017 D2L Corporation.
The D2L family of companies includes D2L Corporation, D2L Ltd, D2L Australia Pty Ltd, D2L Europe Ltd, D2L Asia Pte Ltd, and D2L Brasil Soluções de Tecnologia para Educação Ltda.
Brightspace, D2L, and other marks (“D2L marks”) are trademarks of D2L Corporation, registered in the U.S. and other countries. Please visit d2l.com/trademarks for a list of other D2L marks.
Respondus is a registered trademark of Respondus, Inc.
Blackboard and WebCT are registered trademarks of Blackboard Inc., or its subsidiaries in the United States and/or other countries.
Common Cartridge and IMS Global Learning Consortium are registered trademarks of IMS Global Learning Consortium, Inc. in the United States and/or other countries.
SCORM is a registered trademark of Rustici Software Inc. in the United States and/or other countries.
eCollege is a registered trademark of Pearson Education. All rights reserved.
Moodle is a trademark in the U.S. and/or other countries.
uCompass.com is either a trademark or registered trademark in the U.S. and/or other countries.
IEEE is a registered trademark of IEEE in the United States and/or other countries.
Dublin Core is a registered trademark of Dublin Core Metadata Initiative in the United States and/or other countries.
All other trademarks are property of their respective trademark holders.